
Reference  

Welcome to Motic Images Plus 3.0 ML . Motic Images Plus 3.0 ML is multi-languages software 

offered by Motic China Group Co., Ltd. It is especially designed for individual users and 

provides advanced and easy-to-use functions for editing, analyzing and measuring images. 

Here take the Motic Images Plus 3.0 ML software runs under Windows OS for example to 

introduce the software functions. 

Opening Motic Images Plus 3.0 ML will display the following interface:  

 

The interface is composed of the Title Bar, Menu Bar, Tool Bar, Image Window,Control Panel 

Preview Window 



Menus and Tools 

Reference 

The Menu Bar includes the File, Edit, Image, Measure, Language, Style, View and Help. Click 

the buttons on the Menu Bar to display the corresponding tool bars.  

 

File 

Introduction 

The Menu includes the following commands: New, Open,Save, Save As, Capture,Preview 

Image Comparison, Album, Report, Settings and Exit. Shown below is the corresponding 

tool bar:  

 



New  

The New command enables users to create new image files. Click the New button to bring up 

the following dialog box:  

  

Select the format of the image file to be created from the drop down list located beside the 

Name input box.  

Define the image size by filling in the width and height boxes with appropriate values.  

With the Folder option, define the location where the new image file will be saved.  

Open 

The Open command allows users to open image files supported by the system. The following 

dialog box will display allowing users to select the desired files.  



 

Save 

The Save command allows users to save the current image in the selected format.  

Save As 

The Save As command provides another method for saving the current image. The following 

dialog box will display allowing users to save the image to a different destination and in a 

different format than its source.  



 

Capture 

Selecting the Capture command will bring up the Motic Live Imaging Module (see module 

help guides for more) capture windows which enable users to capture images seen through 

the microscope connected to the computer.  

Note: The capture device can be preset using Setting command of File menu or the Setting 

button on the File Toolbar.  

Image Comparison 

The Image Comparison command enables users to compare two images.Select this command 

to display a window composed of two frames into which two images may be placed side by 

side for comparison.  

 



 

There are four ways to load the images for comparison:  

1.Double click on either frame to load images from local disk for comparison.  

2.Right click within either frame and select Load Image from the shortcut menu to load the 

desired images for comparison. 

 

3.Images may also be dragged into either of the frames directly from the Album or Preview 

window.  

4.Click “Load Image” button to import the selected image.  

Album 

The Album command allows users to open existing images from their files. It also enables 

image amalgamation. Click the Album button to bring up the following window:  



 

Select the desired files from the Folder panel on the left and preview the images in the preview 

window on the right. 

The upper column of the Folder panel displays the Motic Images Plus 3.0 ML image folders, the 

images captured by Motic Images Plus 3.0 ML software will be saved here also. 

 

The lower column of the Folder tab displays the contents of the computer. Click the right 

mouse button in the upper column and lower column of the Folder panel to bring up the 

following popup menus 

 

Double click on the desired image in the preview window to open it.  



Click on the image and drag it into the Preview Window of the interface to open the image 

also. 

Double click on the desired image in the preview window to open it. Users can also open an 

image by clicking the right mouse button to bring up the following popup menu and selecting 

the Open command. 

 

Popup menu functions  

To amalgamate images, click the Amalgamation tab to display the following panel:  



 

Select the desired images and drag them into the Amalgamation panel. Click the 

Amalgamation button and a popup menu listing various amalgamation methods will be 

displayed.  

 

Select an amalgamation method and a dialog box will display to confirm the name of the 

resulting image.  

Clicking the Remove button will remove the selected image, while clicking the Remove All 

button will remove all the selected images.  

Users can also remove the selected image by clicking the right mouse button in the 



Amalgamation panel to bring up the following popup menu and selecting the proper 

command.  

 

Users can also amalgamate images by selecting the desired images in the preview window, and 

then clicking the right mouse button to bring up a popup menu. From the popup menu select 

the Amalgamation command to display the list of amalgamation methods. Finally, select the 

desired method to amalgamate.  

Report 

Introduction 

The Report command allows users to create reports. With Report users are able to load images, 

input text into the report and print or export the report. The Report functions are located in the 

tool bar located at the bottom of the window.  



 

Click the close button located in the top right corner to close Motic Report.  

Click the right mouse button in the Motic Report window to bring up the following popup 

menu:  

 

 Delete: This command is used to delete the selected contents.   

 Bring To Front: This command is used to bring the selected item to the top layer.   

 Send To Back: This command is used to send the selected item to the bottom layer.   

 Full Screen: This command is used to display the Motic Report window in full screen size.   

Tool Bar 

The Report Tool Bar is located at the top of the Report window and displays as follows:  



 

New Page  

The New Page button creates a new report page 

Load 

The Load button brings up the following dialog box from which an existing report may be 

opened。 

 

Save 

The Save button brings up the Save As dialog box which allows users to save the report 

documents as *.mwp format files 



 

Print Current Page 

The Print Current Page button enables users to preview the current report. Press the Print 

Current Page button to display the following interface. 

   



Print Setting 

The Print Setting button brings up the Print dialog box which allows users to set the Printer, 

Print range, Copies and Properties parameters. 

 

 

Color 

The Color button brings up the Color Palette through which users are able to select a text 

color.  

 

Text 

Click the Text button and move the cursor to the location on the report where the text is to 

be displayed, click the left mouse button and begin typing.  



To change the existing captions, click the text to bring up the following dialog box, enter the 

new content 

、 

Font 

The Font button brings up the Font dialog box which allows users to modify the font, font style, 

size, effects and color of the text.  

 

 

Settings 

Introduction 

The Settings command provides access to the Capture, Audio settings. Click the Settings 

button in the toolbar to bring up the following dialog box.  



 

Capture 

Click the Settings button in the toolbar to bring up the following dialog box. Click the Capture 

tab to display the capture settings:  

 

Here, define the file name, image size, frequency and maximum number of images to 

automatically be captured. To choose the Using current date and time as file names option, 

click the check box left of the option.  



Click the OK button to confirm the new settings.  

Audio 

Click the Settings button in the toolbar to bring up the following dialog box. Click the Audio 

tab to display the Audio settings:  

 

Click the check box to the left of the Auto Play option and the music selected in the Playlist 

of the Control Panel will play automatically each time Motic Images Plus 3.0 ML is opened.  

Click the OK button to confirm the new settings.  

Exit  

The Exit command closes the program after prompting users to save any unsaved files.  

Edit 

Introduction 

The Edit Menu includes the following commands: Undo(Ctrl+Z), Redo(Ctrl+Y), Cut, 

Copy,Paste,Rectangle Marquee, Circle Marquee, Ellipse Marquee, Polygon Marquee, 

Irregular Marquee , Select All and Deselect region. The corresponding tool bar functions are 



shown below:  

 

Click the right mouse button in the Image window to bring up a popup menu (see Popup 

menu functions):  

 

Popup menu functions  



Rectangle Marquee 

With the Rectangle Marquee command, users are able to define a rectangular region by 

clicking and dragging with the mouse.  

To move the selected rectangular region, place the mouse pointer on the side of the figure, and 

then click and drag when the cross pointer appears.  

To change the size of the selected region, place the mouse pointer on a corner of the rectangle, 

and then click and drag the mouse when the hand pointer appears.  

Circle Marquee 

With the Circle Marquee command, users are able to define a circular region by clicking and 

dragging the mouse.  

To move the selected circular region, place the mouse pointer at the center of the circle, then 

click and drag the mouse when the cross pointer appears.  

To change the size of the selected region, place the mouse pointer at the extreme point of the 

radius, then click and drag the mouse when the hand pointer appears.  

Ellipse Marquee 

With the Ellipse Marquee command, users are able to define an elliptical region by clicking 

and dragging the mouse.  

To move the selected elliptical region, place the mouse pointer at the center of the ellipse, then 

click and drag the mouse when the cross pointer appears.  

To change the size of the selected region, place the mouse pointer at the extreme point of the 



major or minor half axis, then click and drag the mouse when the hand pointer appears.  

Polygon Marquee 

With the Polygon Marquee command, users are able to define a polygon by clicking and 

dragging the mouse.  

To move the selected polygon, place the mouse pointer on the side of the polygon, then click 

and drag the mouse when the cross pointer appears.  

To change the size of the selected region, place the mouse pointer on a corner of the polygon, 

then click and drag the mouse when the hand pointer appears.  

Irregular Marquee 

With the Irregular Marquee command, users are able to define an irregular region by clicking 

and dragging the mouse. The selected irregular region may be moved using the 

drag-and-drop method when the cross pointer appears. 

Image  

Introduction 

The Image Menu includes the following commands: Brightness Contrast, Hue Saturation, 

RGB, Mirror, Vertical, Rotate 90, Gray Scale, Invert,Image size and Filter . The corresponding 

tool bar functions are shown below:  



 

 

The RGB  box displays the color information at the point of the cursor's current 

location.  

 

The XY box displays the XY coordinates of the cursor's current location.  

 

Brightness/Contrast 

Select the Brightness/Contrast command to bring up the following window:  



 

Dragging the Brightness slider to the left or the right will decrease or increase the brightness 

of the active image. The number to the right of the slider displays the brightness value. The 

value ranges from -255 to +255 and the default value is 0. Dragging the Contrast slider to the 

left or the right will decrease or increase the contrast of the active image. The number to the 

right of the slider displays the contrast value. The value ranges from -127 to +127 and the 

default value is 0.  

Hue/Saturation 

Select the Hue/Saturation command to bring up the following window:  

 

Dragging the Hue slider to the left or the right will decrease or increase the hue of the active 

image. The number to the right of the slider displays the hue value. The value ranges from -360 

to +360 and the default value is 0. Dragging the Saturation slider to the left or the right will 

decrease or increase the saturation of the active image. The number to the right of the slider 



displays the saturation value. The value ranges from -100 to +100 and the default value is 0.  

Red/Green/Blue 

Select the Red/Green/Blue command to bring up the following window:  

 

The three sliders are used to adjust the red, green and blue color channels of the active image. 

Dragging the sliders to the left or the right will decrease or increase the channel value. The 

numbers to the right of the sliders display the red, green and blue color channel values. The 

values range from -100 to +100 and the default value is 0.  

Mirror 

The Mirror command mirrors the current image horizontally.  

Vertial 

The Vertical command mirrors the current image vertically.  

Rotate 90 

The Rotate 90 command rotates the current image clockwise by 90 degrees.  



Gray Scale  

The Gray Scale command convert the current image into gray scale image.  

 

Image Size 

The Image Size command brings up the Image Size dialog box, allowing users to define the 

height and width of the image. The units may be measured in "Pixels" or by "Percent".  

Select the Constrain Proportions checkbox to maintain the image proportions even though the 

size is changing. When this option is selected, adjusting either the Width or Height values will 

automatically influence the other value in order to keep the image in proportion.  

 

Filter 

The Filter command provides a list of filters used to process and create various special effects 

on the current image, including Smooth, Blur, Sharp, Relief, Grease, Lithograph, Mosaic, 



Strengthen Black Region ,Weaken Black Region and User Define Filter.  

To get the effect you want on the current image, please select the corresponding command. 

 

The User Define Filter command brings up the Custom Filter window with which users are 

able to personally define filters.  

 

To define a new filter, click "New", enter the name of the filter and the name will be added to 

the list in the Custom Filter window. Enter values into the blanks to create a filter matrix, divisor 

and bias.  

Click "Delete" and the selected filter will be deleted.  



To open an existing filter, select an item from the list and click "Apply".  

Measure  

Introduction 

The Measure Menu includes the following commands: Line, Rectangle, Circle,Circle(3 Points), 

Arc, Ellipse, Polygon, FreeHandLine ,Irregular, Angle,Auto Segment, Auto 

Calculation,Calibration Wizard and Calibration Table. The corresponding tool bar functions 

are displayed below:  

 

Click the right mouse button in the Image window to bring up a popup menu (see Popup 

menu functions):  



 

Line 

The Line command measures the length of lines. Click the left mouse button on the image and 

drag to create a line. The results are displayed in the measure info box.  

Place the mouse pointer at the extreme point of the line, then click and drag the mouse when 

the hand pointer appears to change the length of the line. The results in the measure info box 

will change correspondingly as well.  

Place the mouse pointer on the line, then click and drag the mouse when the cross pointer 

appears to move the line.  

Rectangle 

The Rectangle command measures the width, height, area and perimeter of rectangles. Click 

and drag the left mouse button on the image to create a rectangle. The results are displayed 



in the measure info box.  

Place the mouse pointer at the vertex of the rectangle, then click and drag the mouse when the 

hand pointer appears to change the size of the rectangle. The results in the measure info box 

will change correspondingly as well.  

Place the mouse pointer on an edge of the rectangle, then click and drag the mouse when the 

cross pointer appears to move the rectangle.  

Circle 

The Circle command measures the radius, area and perimeter of circles. Click and drag the 

mouse to create a circle. The results will be displayed in the measure info box.  

Place the mouse pointer at the extreme point of the radius, then click and drag the mouse 

when the hand pointer appears to change the size of the circle. The results in the measure info 

box will change correspondingly as well.  

Place the mouse pointer on the center of the circle, then click and drag the mouse when the 

cross pointer appears to move the circle.  

Circle (3 points) 

The Circle (3 points) command measures the radius, area and perimeter of circles. The results 

will be displayed in the measure info box. Place the mouse pointer on any of the three points 

on the circle, then click and drag the mouse when the hand pointer appears to change the size 

of the circle. The results in the measure info box will change correspondingly as well.  

Place the mouse pointer on the circle, then click and drag the mouse when the cross pointer 



appears to move the circle.   

Arc 

The Arc command allows users to measure the radius, arc length and perimeter of circles. The 

results will be displayed in the measure info box.  

Click and drag the mouse to create a arc. Place the mouse pointer at the red point of the arc, 

then click and drag the mouse when the hand pointer appears to change the shape of the arc.  

Place the mouse pointer on the arc, then click and drag the mouse when the cross pointer 

appears to move the arc. 

Ellipse 

The Ellipse command measures the major half axis, minor half axis, area and perimeter of 

ellipses. Click and drag on the image to create an ellipse (the initial shape drawn will be that 

of a circle). The results will be displayed in the measure info box.  

Place the mouse pointer on the extreme point of the major or minor half axis, then click and 

drag the mouse when the hand pointer appears to change the size and shape of the ellipse. 

The results in the measure info box will change correspondingly as well.  

Place the mouse pointer on the center of the ellipse, then click and drag the mouse when the 

cross pointer appears to move the ellipse.  

Polygon 

The Polygon command measures the area and perimeter of polygons. The results will be 



displayed in the measure info box.  

To complete a polygon, double click the left mouse button after setting the required points 

(single click to set the points of the polygon). After the polygon is closed, the results will display.  

Place the mouse pointer on any point of the polygon, then click and drag the mouse when the 

hand pointer appears to change the size of the polygon. The results in the measure info box 

will change correspondingly as well.  

Place the mouse pointer on any edge of the polygon, then click and drag the mouse when the 

cross pointer appears to move the polygon.  

Freehand line 

This Freehand Line command allows users to measure the length of free lines. The results will 

be displayed in the measure info box. 

Place the mouse pointer on the free line, then click and drag the mouse when the cross pointer 

appears to move the free line. 

Irregular 

The Irregular command measures the area and perimeter of irregular figures. Click and drag 

the left mouse button on the image to drawn an irregular image, release the button to 

complete the shape. The results will be displayed in the measure info box.  

Click and drag the mouse when the cross pointer appears to move the irregular figure.  



Angle 

The Angle command measures the degree of an angle. Click the left mouse button on the 

image to set the first point of the angle. Move the mouse and click the left mouse button to 

set the second point. Once the third point is set an angle will be produced. The results will be 

displayed in the measure info box.  

Place the mouse pointer on any point of the angle, then click and drag the mouse when the 

hand pointer appears to change the degree of the angle. The results in the measure info box 

will change correspondingly as well.  

Place the mouse pointer on an edge of the angle, then click and drag the mouse when the 

cross pointer appears to move the angle.  

Auto Calculation 

The Auto Calculation command provides detailed data of the objects segmented from the 

image.  

The Auto Calculation Result window will then be displayed. In this window, access detailed data 

of the segmented image, such as the number of objects, total area, percentage of total area, 

minimum object area, maximum object area, average object area, minimum object perimeter, 

maximum object perimeter, average object perimeter and the serial number, area and 

perimeter of respective objects.  

To access the data of a certain object, click on the object in the image window and the data for 

that object will be highlighted in dark blue.  

Click on the data of the desired object(s) and the corresponding object(s) will flicker in the 



image window.  

Click and drag on a particular data item to change its location in the list of results.  

 

Click the Export button to bring up the Save As dialog box with which users can 

use to export calculation results and save them as a Text file(*.txt) or CVS file(*.cvs).  



 

Calibration Wizard 

The Calibration Wizard command provides three calibration methods: Calibrate with 

Calibration Circle, Scale Cross and Scale Line.  

Select the Calibration Wizard command to bring up the following window:  



 

Select the different tabs to display the corresponding panels. Follow the instructions outlined 

in the corresponding panel to calibrate.  

Calibration Table 

The Calibration Table command brings up the Calibration table. All calibration data are saved 

here for later measuring.  

If the Scale check box is selected, the measurement results of a certain object will not change 

no matter which size the image is when captured. For example, although a distance of 2500um 

looks different in images of different sizes (640x480 vs. 320x240) the measurement results will 

still be the same: 2500um.  



 

Language 

The Language menu brings up the following.  Select a language from the Select language 

drop down list. the interface will display in the selected language.  

 



Style 

Four color styles are provided ,click “Style” button and select one of them to switch the 

interface style.  

 

View 

Display all panel statust.When you select it ,the panel will display in the software interface 

 

Help 

The Help menu has two commands:  

 

 

About: Display the program's copyright and version information.  

Help: Provide detailed instructions on how to use the program. 



Control Panel 

Introduction 

When an image is opened in Motic Images Plus 3.0 ML, the following Control Panel will 

display.  

 

 

This Control Panel is composed of the following tabs: Text, Paint, Measure, and Audio.  

Paint 

Click the Paint tab in the Control Panel to display the Paint panel:  

 

Click the Icon button to bring up a dialog box which provides a variety of icons to add 

to the current image.  



 

Select a desired icon and click on a position of the image to place the icon.  

The circles under the title Illumination represent the direction of the lamp-house which will 

add shadow to the selected icon. Choose a direction by clicking the corresponding circle. The 

slider bar under the circles displays the angle of the lamp-house, dragging to the left or the 

right will decrease or increase the degree of the angle.  

Click the Rotate 90 button to rotate the icon 90 degree clockwise.  

 

With the buttons draw different shapes in the current 

image.  

 

 



To define a line and fill color, click the boxes next to the options to bring up the color palette 

from which a color may be selected.  

Choose to add fill color to the figures or not by clicking the check box left of the option.  

To set the line width, Select the line width in the drop down list  

With the button, draw lines in the current image.  

With the button, draw rectangles in the current image.  

With the button, draw polygons in the current image.  

With the  button, draw circles in the current image.  

With the button, draw ellipses in the current image.  

With the button, draw irregular figures in the current image.  

Text 

Click the Text tag in the Control Panel to display the Text panel:  

 

Click the Color button  to bring up the color palette, from which a text color may be 

selected.  

Click the Text button to add text to the cursor's current location.  



Click Font drop down list to select the font . 

Click Size drop down list to select the font size. 

Click Font Style down list to select font style. 

The Align Left button aligns the selected texts, numbers or inline objects to the left with a 

ragged right edge.  

The Center button centers the selected texts, numbers or inline objects.  

The Align Right button aligns the selected texts, numbers or inline objects to the right with a 

ragged left edge.  

Measure 

Click the Measure tab to display the Measure control panel:  

 

The settings in the Measure panel have a direct affect on measurement results.  

From the Objective Lens drop down list, select the objective lens that was used to capture the 

current image.  



 

From the Units drop down list, select the desired measurement units.  

 

Click the Color button to display the color palette where a fill color may be selected for 

segmented objects. 

 

From the Accuracy drop down list, select the number of digits to be displayed after the 

decimal point in the measurement values.  

 



 The Measure Table button opens the following window which is composed of two tabs, 

Measure Table and Options: The Measure Table tab lists all measurement results  

 

To export the data in the Measure Table, click "Export" to bring up the following dialog box 

with which users are able to save the data as *.txt or *.cvs files.  

 



Click the Common tab under the Options tab to display the Common panel.  

Here, set the line width, line color, point color, point type, arrow size and line type of the figures 

and preview the new settings in the Preview window.  

 

Default radio is selected by default Please uncheck “Default” radio to cancel the default 

settings and then customize the settings。 

Click Line color and Point color to bring up the color palette which user can customize the line 

and point color.Click Line width and Point width to customize the line and point width.Click 

text tab to customize the font and font size ect . Click “Apply” button to apply the new settings.  

Select “Apply to all” radio to apple the new settings to all the figures in the image. 

Line Type provides Normal, Single arrow, Double arrow options for selection.  

Click Marker to mark the flag color ,flagpole color and size. 



 

Magnifier 

Click the Magnifier button in the toolbar to display the Magnifier panel: 

Click the button to reduce the magnification and click the button to increase the 

magnification. The maximum magnification is 800%.  

 

Audio 

Click the Audio tab to display the Audio control panel:  



 

Click the Play List button to bring up the following Playlist window:  

 

Click the right mouse button in the window to display this popup menu:  

 

To add music to the playlist, select the Add command to display the Open dialog box:  



 

Select the desired music files, click the Open button and the selected music will be added to 

the playlist. If the Auto Play option in the Audio panel of the Setting dialog box has been 

selected, the music in the playlist will be played in turn automatically each time Motic Images 

Plus 3.0 ML is run.  

To remove the music listed in the playlist, select the Remove All command from the popup 

menu.  

If music exists in the playlist, click the Play button to play the music; click the Stop 

button to stop play and click the Pause button  to stop the music temporarily, to 

continue play, click the Pause button again. The slider at the bottom of the Audio tab shows 

the progress of the music that is being played. Click the Add audio to current image button 

, move the cursor onto the image and left click to display the following box:  

 



Click the Play button to play the audio files listed in the playlist; click the Stop button to 

stop play and click the Pause button to temporarily stop play, to continue play, click the 

Pause button again.  

Click the Record button to display the Record window with which users are able to record 

sound, music, etc. Click the Record button in the window to start recording; click the Stop 

button to stop recording. Users are also able to name the sound or music file - input a name 

into the Name box, click the OK button and the name will display in the play box shown above.  

 

Click the button to bring up the Open dialog box from which users can open an existing 

audio file. Click the Open button and the selected file will be added to the play box shown 

above.  



 

Preview Window 

The Preview Window is located to the bottom of the image window.  

With the Preview Window users are able to preview images that have been opened. When an 

image is opened it will automatically display in the preview window.  

 

How to... 

Use the Popup Menus 

In the Image window 

Click the right mouse button in the image window to display the following popup menu:  



 

Deselect: This command deselects the selected objects.  

Lock: This command locks the selected objects making it impossible to move them around. 

Selected regions cannot be locked. 

Freeze: This command freezes the location and size of the selected measured figure.  

Freeze All: This command freezes the location and size of all the measured figures.  

Delete: This command deletes the selected object. It cannot delete a selected region。 

Delete All: This command deletes all the objects that have not been locked or frozen. It cannot 

delete selected regions. 

Deselect region: This command deselects the selected regions. 

Up one layer: This command brings the selected item up a layer when there are several items 

on the image. 



Down one layer: This command brings the selected item down a layer when there are several 

items on the image. 

Up to top: This command brings the selected item to the top layer when there are several 

items on the image. 

Down to bottom: This command brings the selected item to the bottom layer when there are 

several items on the image. 

Fit to Window:This Command resize the image to fit into the current window.  

Full Screen: This command brings the image window into full screen view. 

Scale: This Command resize the current image by scale.  

Properties: This command brings up the Properties dialog box which allows users to define 

the selected object's parameters. 

 

File Info: This command brings up the File Info dialog box which provides information about 

the current image. 



 

In the Album window 

Click the right mouse button in the upper column of the Folder panel to bring up the following 

popup menu:  

  

 New: This command enables users to add a new folder to the selected folder.  

 Rename: This command enables users to rename the selected folder.  

Delete: This command enables users to delete the selected folder  

 

Set as default capture folder: This command enables users to set the selected folder as the 

default capture folder. Images captured using this program will then be saved in the selected 

folder automatically  

Refresh(F5): This command enables users to refresh the contents displayed in the upper 

column of the Folder panel. Pressing the F5 key will refresh the contents as well。 



 

Click the right mouse button in the lower column of the Folder panel to bring up the following 

popup menu:  

 

New: This command enables users to add a new folder to the selected folder.  

Rename: This command enables users to rename the selected folder.  

Delete: This command enables users to delete the selected folder.  

Refresh(F5): This command enables users to refresh the contents displayed in the upper 

column of the Folder panel. Pressing the F5 key will refresh the contents as well. 

Click the right mouse button in the preview window right of the Album window to bring up the 

following popup menu。 

 

Open: This command enables users to open the selected image.Press “Ctrl” and “O” in the 

keyboard at the same time can open the selected image also. 



Amalgamtion:This command display various amalgamation methods. Select an amalgamation 

method and a dialog box will display to confirm the name of the resulting image. 

 

Rename: This command enables users to rename the selected images. Ctrl+R is the shortcut 

of  rename function. 

Delete: This command enables users to delete the selected image. Ctrl+Del is the shortcut of 

delete function. 

Copy: This command enables users to copy the selected image and save it to the clipboard 

Ctrl+C is the shortcut of copy function. 

Cut: This command enables users to cut the selected image and save it to the clipboard. Ctrl+X 

is the shortcut of cut function. 

Paste: This command enables users to paste the content from the clipboard to a desired 

location Ctrl+V is the shortcut of paste function. 

Select All: This command enables users to select all the images in the folder. Ctrl+A is the 

shortcut of select all function. 

Emport: This command enables users to emport the image in the album to the desired 

location. 



Import: This command enables users to import the image in the desire location to the album. 

Refresh: This command enables users to refresh the selected folder.F5 is the shortcut of refresh 

function. 

 

Calibrate 

Introduction 

Motic Images Plus 3.0 ML provides three calibration methods: Calibrate with Calibration 

Circle, Calibrate with Scale Cross and Calibrate with Scale Line.  

click the Calibration button in the Measure tool bar to displaythe corresponding toolbar.  

 

Select the Calibration Wizard command to bring up the Calibration Wizard window. Select a 

calibration method by selecting the corresponding tab.  

Calibrate with Calibration Circle 

To calibrate with a calibration circle, select the Calibration Wizard command to display the 

Calibration Wizard window. Click the Calibrate with Calibration Circle tab to display the 

corresponding panel.  

Click the Load Image button to bring up the Open Image files dialog box from which a 

calibration circle may be selected for calibration. Click the Open button to load the selected 



image.  

 

Confirm the objective lens used to capture the selected image and input the diameter of the 

calibration circle. Click the Calibration button to complete calibration.  

 

The Save Sign dialog box will display when the Calibration button is selected. Input a Sign 

Name by clicking the corresponding objective lens from the list at the left of the dialog box. 

Next, click the Save button to save the calibration results for measuring.  



 

When calibration is complete, click the Close button to close the Calibration Wizard window.  

Calibrate with Scale Cross 

To calibrate with a scale cross, select the Calibration Wizard command to display the 

Calibration Wizard window. Click the Calibrate with Scale Cross tab to display the 

corresponding panel. Click the Load Image button to bring up the Open Image files dialog box 

from which a scale cross may be selected for calibration. Click the Open button to load the 

selected image.  

 



When the image is loaded, a circle will appear on it. Modify the color by clicking the Circle 

Color button to bring up the palette where a scale cross color may be selected.  

First, put the center of the circle (set as "O") in the origin of the scale cross. Next, put a point 

(set as "A") that is horizontal with the center of the circle on the horizontal line, and put a point 

(set as "B") that is vertical with the center of the circle on the vertical line. The magnifier 

window under the image window will help users accurately to place the points.  

Confirm the objective lens used to capture the selected image and input the actual length of 

"OA" in the "Width" bar and the actual length of "OB" in the "Height" bar. Click the Calibration 

button to complete calibration.  

 

The Save Sign dialog box will display when the Calibration button is selected. Input a Sign 

Name by clicking the corresponding objective lens from the list at the left of the dialog box. 

Next, click the Save button to save the calibration results for measuring.  



 

When calibration is complete, click the Close button to close the Calibration Wizard window.  

Calibrate with Scale Line 

To calibrate with scale lines, select the Calibration Wizard command to display the Calibration 

Wizard window. Click the Calibrate with Scale Line tab to display the corresponding panel.  

Click the Load Image button to bring up the Open Image files dialog box from which scale lines 

may be selected for calibration. Click the Open button to load the selected image.  

 



Click the Vertical tab to load the vertical scale lines. Click the Load Image button to bring up 

the Open Image files dialog box from which vertical lines may be selected for calibration. Click 

the Open button to load the selected images.  

Note: The same steps apply for both the Vertical and Horizontal lines but the two images must 

be captured by objective lenses of the same magnification.  

 

Once the image is loaded, a line will appear on it. Modify the color of the line by clicking the 

Line Color button to bring up the palette where a line color may be selected.  

Drag the two ends of the line (set as "A" in the horizontal line and as "B" in the vertical line) 

to two different scales. The magnifier window under the image window will help users 

accurately place the points.  

Confirm the objective lens used to capture the selected images and input the actual length of 

"A" in the "Width" bar and the actual length of "B" in the "Height" bar. Click the Calibration 

button to complete calibration.  



 

 

 

The Save Sign dialog box will display when the Calibration button is selected. Input a Sign 

Name by clicking the corresponding objective lens from the list at the left of the dialog box. 

Next, click the Save button to save the calibration results for measuring.  



 

When calibration is complete, click the Close button to close the Calibration Wizard window.  

 


